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Please read this very carefully as it  is a LEGAL AGREEMENT between YOU the software end user
and PANTOGRAMS MANUFACTURING CO. INC.  By installing this package you are  agreeing
to be bound by the terms of this contract.  If you do not wish to enter this contract, please do not open
this SOFTWARE package. Simply return it to your dealer.

You have  the right to use one copy of the enclosed Pantograms Manufacturing Co. Inc.  software
program but must abide by  the terms  that follow:

COPYRIGHT.  This software  is owned by Pantograms Manufacturing Co. Inc.  and is protected by
United States copyright laws and international treaty provisions.

GRANT OF LICENSE.   Purchasers of this software are granted the right to use one copy of the
specific software program that they receive from Pantograms Manufacturing Co. Inc.

RESTRICTIONS.   You agree not to or allow anyone else to reverse engineer, de-compile, or disas-
semble the software.

OUR WARRANTY TO YOU:  The Pantograms Manufacturing Co. Inc. Limited Warranty certifies
to you that this software will perform substantially in accordance with the accompanying documen-
tation for a period of 12 months from the date of receipt. We further certify that the installation
disks, security device and reference manual accompanying this software will be substantially free
from defects in materials and workmanship under normal use and service for a period of 12 months
from the date of receipt.

IF YOU HAVE A PROBLEM:  Pantograms Manufacturing Co. Inc. will repair or replace  the
software and/or its security device if they do not meet Pantograms Manufacturing Co. Inc. Limited
Warranty. We reserve the right, however, to void this Limited Warranty if failure of the software
and/or security device has resulted from accident or misuse. We will, of course warranty any re-
placement software and security device for the remainder of the original warranty period or for 30
days, whichever is longer.

THERE ARE NO OTHER WARRANTIES: The above  constitutes our entire warranty to you and
the  exclusive remedy. Pantograms Manufacturing Co. Inc. will disclaim any other warranties,
whether expressed or implied. This includes but does not limit any  implied warranties of merchant-
ability and fitness for a particular purpose. This encompasses the software, the written materials
and the  security device that are enclosed.

THERE IS NO LIABILITY FOR CONSEQUENTIAL DAMAGES: Under no circumstances will
Pantograms Manufacturing Co. Inc., its suppliers and  dealers be held  liable for  damages  arising
from  the use of or inability to use this Pantograms Manufacturing Co. Inc. product, even if
Pantograms Manufacturing Co. Inc. has been advised of the possibility of such damages. This
includes any  damages for loss of business profits, business interruption, loss of business informa-
tion, or other pecuniary loss.

 Licensing Agreement between
Pantograms Manufacturing Co. Inc.

and the Purchaser
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The File Menu allows you to create new designs, open existing
designs, and save designs, as well as giving access to the design
database.

To select a menu item move the mouse over your choice and press
the left mouse button. This is called a mouse click. This will cause
the menu to open and show it’s available options.

New - Creates a clear work area that you can paste designs into.

Open - Opens an existing design into a new work area.
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WELCOME

FILE  MENU

Welcome to Embroidery Magic by Pantograms. This tutorial will
give you an overview of the features of the software such as the basic
operation of menus and toolbars, opening designs, manipulating de-
signs, adding lettering and saving designs.

MENU AREA

The Menu Area is at the top of your software screen. (Example:
File, Edit Tools etc.) As your mouse moves over menu names, the
name appears to raise.
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Close - Closes the active work area.

Save - Saves the design in the active work area.

Save As - Allows you to save the design in the active work area

under a different name or file format.

Design Database - Accesses the design database.

Add Design To Database - Adds the design in the current work
area to the design database.

Add Directory of Designs To Database - Allows you to add a
complete set of designs to a database.

Batch Conversion - Allows you to open multiple files in one step

and convert them to a different type of file.

Print  - Prints the design in the active work area.

Exit - Exits the program.

Most Recent Files Opened - Shows you the last four designs you

opened, and allows you to reopen them simply by clicking on one
of them.
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The Edit Menu allows you to manipulate designs.

Cut - Copies the selected design to the clipboard and removes it

from the work area.

Copy - Copies the selected design to the clipboard.

Paste - Pastes a copied design to the work area.

Delete - Deletes the selected design from the work area.

Mirror - Allows you to mirror the selected design horizontally or

vertically.

Rotate - Allows you to rotate the selected design.

Move - Moves the selected design in the work area.

Scale - Allows you to enlarge or reduce the selected design.

Select All - Selects all designs and text in the current work area.
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EDIT  MENU
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Paste From - Pastes a design from another file into the current

work area.

Center - Centers the design in the work area.

Delete Short Stitches - Removes short stitches from the design

that could cause sewing problems.
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TOOLS MENU

The Tools Menu allows you to select one of the following tools:

• Object Selector

• Lettering

Object Selector - Is the tool used to select designs or text on the
screen.

Lettering - This option allows you to select the point in the design

for adding lettering.
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DISPLAY MENU

The Display Menu allows you to select and set the different view-
ing options for the current work area.

Refresh - Redraws the design in the work area.

Real View - Allows you to view the current design as simulated

embroidery on a fabric background.

Actual Size - Views the design at actual size.

Fit To Screen - Zooms in so that the entire design just fits on the

screen.

Display Hoop - Allows you to select a hoop size to determine the

size needed for sew out.

Create New Hoop – allows you to create a custom size hoop
needed for sew out.
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SYSTEM MENU

The System Menu allows you to customize some software settings
to your preference.

Grid  - Shows or hides the grid lines in the work area.

Work Area Background - Allows you to change the background
color of the work area.

Cursors - Allows changes to the cursor used in the work area.

Set Design Colors To Default - Set the twelve needle colors to the

preset default colors.

Set Default Colors - Allows you to set the default design colors.

Screen Scale - Allows you to change the scale on the screen.

Units Of Measurement - Allows you to select which units to

display measurements.

Language - Allows you to select a different language for the

software.
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WINDOWS MENU

The Widows Menu allows you to select how design work areas are
displayed.

Cascade - Cascades design windows.

Tile - Tiles design windows.

Most Recent Files Opened - Shows all open designs, allowing
you to easily select a work area.

HELP MENU

The Help Menu runs the tutorial.

Help - Displays the tutorial.

About - Provides technical information about the software.
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TOOLBARS

The Toolbars at the top and left of the work area allow you to
easily access many of the most commonly used tools.

To select an option from the toolbars, move your mouse over the
tool bar button and press your left mouse button. If you leave the
mouse over the toolbar button for 2 or more seconds you will be
given a description of what the tool is.

The Main Toolbar at the top of the work area allows
access to the tools used to load and save designs as
well as display options.

New Design - Opens a new empty work area.

Open Design - Opens a design in the work area.

Close Design - Closes the active design in the work

area.

Save Design - Saves the design. To save the file to a

new name select the Save As option.

Design Database - Allows access to the design data-

base.
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Add Design To Database - Adds the design in the
active work area to the design database.

Print Design - Prints the design in the active work
area.

Exit System - Exits the software.

Select Entire Design - Selects all designs and text in

the active work area.

Object Selector - Is the tool used to select the design

or the text that you wish to manipulate.

Zoom In - Is the tool used to zoom in on your design.

Fit To Screen - Fits the whole design to the screen so

you may view all of the design.

No Zoom - Displays your design at its actual size.

Real View - Displays the active design as simulated
embroidery on actual fabric.
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EDIT  TOOLBAR

The Editing Toolbar on the left side of the work area
gives you access to the tools to manipulate the active
design.

Lettering - Allows you to add text to the work area.

Cut Selection - Copies the selected design to the
clipboard and removes it from the active work area.

Copy Selection - Copies the selected design to the

clipboard.

Paste From Clipboard - Pastes the contents of the

clipboard to the current work area.

Rotate Selection - Rotates the selected design.

Move Selection - Allows you to move the selected

design.

Scale Selection - Reduces or Enlarges the selected
design.
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Delete Selection - Removes the selected design from
the work area.

Mirror Selection - Allows you to mirror the selected
design horizontally or vertically.

Center Design - Centers the design in the work area.

Delete Short Stitches - Deletes short stitches from

the design that could possibly cause sewing problems.

Paste From Design File - Pastes a design from

another file into the current work area.
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The Rulers are at the right and top of the design area. They allow
you to guage the size of your design. The increments on the ruler
are based on your units of measurement selection.

DESIGN AREA

RULERS

The Design Area is the blank area inside the top and left rulers and
the right and bottom scroll bars. This  is the area where you insert
and work on designs.

NEEDLE BUTTONS

These are the twelve needle colors on the right side of the Edit
Toolbar to use in the creation of a design. Select a needle number
and click on the palette to change the color for that needle.

GUIDE LINES

Click the gray area in the horizontal or vertical rulers to display a
guide line. Position the guide line by clicking and holding the left
mouse button on the black guide and dragging it to the desired
position.Turn off a guide line, by clicking on the black guide with
the right mouse button.

Pantograms Embroidery Magic                                     126/99



The Sequence bar located at the bottom of the vertical ruler shows
all the colors in the design. Select a color in the bar. The needle
number and corresponding color in the design will flash red. This
indicates which area of the design and needle are assigned that
color.

UNIT  BUTTON

COLOR SEQUENCE BAR

This button is located at the top of color needle buttons between
the horizontal and vertical rulers. It provides an easy way to
change the units of measurement. Click and release the left mouse
button to change the selection.

SCROLL BARS

The scrollbars at the bottom and right of design area allow you to
scroll your design so you may view different portions of your
design.
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STATUS BAR

The Status bar at the very bottom of the software screen shows
information about the design.

X Position - The X Position displays the current X coordinates of
the mouse.

Y Position - The Y Position displays the current Y coordinates of
the mouse.

Length - Length shows the distance from the last point that was

clicked on to the current position of the mouse.

Stitches - This shows the total number of stitches in the design.

Design Size H: W: -  This shows the height and width of the

design.
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OPENING DESIGNS

To open a design you may click on either the Open Button on the
Main Toolbar or select Open from the File Menu.

The Open Design File dialog box is then displayed.

Click on the Folder where the design is located.

Now click on the design you wish to open.

When you click on the design the name will show up in the file
name box.

Now, click on Open to bring the design into Embroidery Magic.

That’s how easy it is to open a design in Embroidery Magic.
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CUT, COPY & PASTE

The Cut, Copy & Paste features of Embroidery Magic give you the
flexibility to easily change a design. Let me show you how it
works.

Cut Example:

First, click on the object selector in the Main Toolbar.

Now click on the design to select it.

Then click on the Cut Button in the Edit Toolbar.

Notice, that the design we had selected has disappeared, but don’t
worry it has been copied to the clipboard.

Click on the Paste Button to retrieve the design from the clipboard.

When you paste from the clipboard, the design will always appear
in the top left corner of the design area.

To move the pasted design click & hold down your left mouse
button and drag it to the desired position.

That’s how Cut & Paste works, now lets see how Copy and Paste
can help you create more interesting designs.
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Copy Example:

With the design selected lick on the Copy Button in the Edit
Toolbar.

Even though it appears nothing happened, the design was copied to
the clipboard. Click on Paste to add the copied design to the design
in the work area.

Once again, to move the pasted design, Click & hold down the left
mouse button and move it to the desired position.

When you deselect the pasted design you will see that both peices
of the design become one. Move them both to their new position.

That’s how easy it is to use the Cut, Copy and Paste features of
Embroidery Magic.
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ROTATING DESIGNS

To rotate a design click on the object selector in the Main Toolbar.

Then click on the opened design in the work area to select it.

Now click on the Rotate Button in the Edit Toolbar.

The Roate Selection screen is displayed.

Click on the arrows to get the desired amount of rotation. For this
example set rotation to 45 degrees by either typing in the value in
teh Angle of Rotation text box or by clicking ont he right arrow on
the scroll bar.

When you have the angle you want click on Ok to apply it.

As you can see your design has been rotated to the requested angle.

That’s how easy it is to rotate designs in Embroidery Magic.
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MOVING DESIGNS

To move a design click on the Select All Button on the Main
Toolbar.

Now click on the Move Button on the Edit Toolbar.

The Move Selected Objects screen is displayed

Notice there are two different move methods, Relative Move and
Absolute Move. Use the Relative Move first.

Enter values to move the design approximately 1 inch to the right
and a quarter inch down.

Click on Ok to apply the change.

You can see how the values that were entered affected the design.
Now lets use the other move method.

Click on the Move Button on teh Edit Toolbar.

Click on the Absolute Move option.

Enter -2 in teh X coordinates box and -1 in teh Y coordinates box.

Click the left bottom option button to indicate that the lower left
corner of the design should move to the coordinates entered.

Click on Ok to make the move.
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Notice that the left bottom corner of the design has moved to the
coordinates entered.

Remember that you can also move selected objects by clicking and
holding down the left mouse button and moving to the new posi-
tion.

That’s how easy it is to move objects in Embroidery Magic.

SCALING DESIGNS

To scale a design click on the object selector on the Main Toolbar.

Now click on the opened design in the work area to select it.

Then click on the Scale Design Button on the Edit Toolbar.

The Sacle Selected Objects screen is displayed.

notice there are two different scale methods, Sclae by Percentage,
and Scale by Size. Use the Scale by Percentage first.

Change the horizontal scale to 120 percent of the original size.

Notice that the vertical scale changed at the same time. This
happened because Maintain Aspect Ration was checked at the
bottom of the screen.

Click Ok to apply the scaling.
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You can see how the scaling was applied.

Click on the Scale Design Button from the Edit Toolbar again.

Click on Scale by Size.

Enter the new horizontal size of 1.0039 In.

Once again notice how the vertical size changed since we had
Maintain Aspect Ration checked.

Click on Ok to apply the scaling.

You can see how the scaling was applied.

Another way to scale selected designs is to click and hold down
the left mouse button on one of the selection handles then drag it
to the desired size and release the mouse button.

This also allows you to add some artistic flair since you can cause
some neat distortions.

That’s how easy it is to scale designs in Embroidery Magic.
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MIRROR DESIGNS

To Mirror a design click on the object selector on the Main
Toolbar.

Now click on the opened design in the work area.

Click on the Mirror Button on the Edit Toolbar.

The Mirror Selected Objects screen is displayed.

For the first example, do a horizontal mirror. Click on the Horizon-
tal Mirror check box.

Click on Ok.

As you can see the design has flipped from left to right.

Click on the Mirror Button on the Edit Toolbar again.

Click the Vertical Mirror check box this time.

Click on Ok to apply the mirror.

As you can see our design has now flipped top to bottom.

Click on Mirror one more time from the Edit Toolbar.

Click on the Vertical Mirror check box.
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And now click on the Leave Original check box option.

Click on Ok to mirror the design.

This is the effect of Leave Original. A copy of the design was
made and mirrored leaving the original unaffected.

You can now move the copy to create an artistic effect.

That’s how easy it is to mirror designs with Embroidery Magic

ADDING LETTERING

To add lettering to a design, click on the Lettering Tool in the Edit
Toolbar.

Now click where you would like to place the text in the design
area, remember the text will be centered on this point.

The Lettering Screen is displayed.

This Lettering Screen is where you will make selections on the
look of your text.

Text - This is the Text Box, where you will type in the lettering.
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Spacing - These are your spacing selections. The setting you make
here will affect how close together your characters and lines are.

Standard (Kerning) -  If you select Standard (Kerning) for
spacing your letters will be spaced according to the letters
that follow.

Mono Spacing - If you select Mono Spacing each letter

will take up  the same amount of space in the line.

Lettering Spacing - This is the amount of space you want

to have between characters in your lettering.

Line Spacing - This is the amount of space you want to
have between the bottom of one line of text to the bottom
of the next line.

Special Spacing - Special spacing is used for characters in

connected scripts which are not actually connected.

Baseline - Line Type - These options determine the appearance

of the text’s baseline.

Line will keep the letters in a straight line, while Arc will
place them on an arc.
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Rotation - This will allow you to rotate the lettering to any angle.

Rotation Options - This box becomes available when you select

the Arced Baseline, it allows you to select up or down arc as well
as the arcs radius.

Available Characters - These are the Available Characters for the
current font.  You will notice that some fonts have more characters
than others.

If you click on one of the characters you will be shown
what it looks like in the display.

Located under the display is the Keystroke assigned to the
character.

Density - The density setting affects the spacing between stitches

that fill the character.

Column Width - Column width affects the appearance of each

letter. If you make this value larger your letters will appear bolder.

Letter Width - Letter width will make the characters in the text
wider or narrower.

Letter Angle - The letter angle adjustment will allow you to
create italicized effects with your lettering.
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Preview - This preview window will give you an idea of how the

settings will affect your lettering.

Fonts - These are the list of fonts that you have available to use.

Lettering Type - The lettering type option allows you to create

normal lettering or 3 letter monograms.

If you have selected normal then the top box of Letter Size
is used for the size.

If you selected monogramming then all the boxes of Letter
Size correspond to each character in the monogram.

Digitized Size - The digitized size allows you to make a judment
about how large or small you can make your lettering.

Lock Stitch & Trim - These options will allow you to choose

where you place lock stitches and trims in your lettering after each
letter, word or line.

Now add some lettering. First choose the font you wish to use.

Click on the Fonts down arrow to show the list of fonts.

Select the font of your choice.

Now type in some text.
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Click on Arc. The Arc Options selection box becomes enabled.

Change the radius of the arc to 3 to make it curve less.

Click on Ok to insert the text.

As you can see the lettering was inserted at the point you clicked
on in the design area.

Click on Text Properties located at the lower right corner of the
design area.

Now make the lettering slightly smaller by changing the letter size.
Change it to .5 In.

Click on Ok to apply the change.

By pressing and holding the left mouse button within the lettering
you can move it to any position on the design.

Once you are happy with your lettering, click on End Text at the
lower right corner of the design area.

That is how easy it is to add and manipulate lettering with Embroi-
dery Magic.
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SAVING DESIGNS

To save your opened design click on the Save Button on the Main
Toolbar.

The Save Design File dialog box is displayed.

Select the folder where you want to save your design.

Now type in the name that you will save the design as in teh File
name text box.

Then select the type of file you wish to save the design as. Click on
teh down arrow on the “Save as Type” combo box and select a
type.

Click on Ok to save the design.

You should always check the title bar at the very top of the soft-
ware screen to see that the design was saved in the correct place.

That’s how easy it is to save a design in Embroidery Magic.
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To zoom in or out on your design so that it just fits in the screen,
click on the Fit To Screen Button on the Main Toolbar.

To see your design at actual size click on the 1 to 1 Button in the
Main Toolbar.

Another way to zoom in on a piece of a design is to select the
zoom tool on the Main Toolbar.

Then drag a box around the area you want to zoom in on.

To see your design as simulated embroidery on an actual fabric
swatch, click on the Real View Button on the Main Toolbar.

The Real View screen is displayed

Embroidery Magic comes with many different samples of fabric.
Click on the down arrow on the Fabric Combo Box to see some of
the choices.

Click on the down arrow to get to the fabric you wish to use.

Click on your choice to select it.

As you can see at the bottom of the screen you have the choice to
print the real view or to save it as a bitmap that you could include
in a document.
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Click on Close to continue.

Another important feature in Embroidery Magic is the ability to
Create and Display Hoops over your designs. Click on Display in
the Main Menu.

Click on Display Hoop.

Now click on Create New Hoop.

The Create New Hoop screen is displayed.

The 1st step to creating a new hoop is to give it a name, preferably
a descriptive one.

Type a name for the new hoop in the Hoop Name text box.

Select a hoop style. For this example the default rectangular has
been selected.

Now reduce the width of the hoop to 4 inches in the Hoop Size
selection box.

Notice the safety margins. These will allow you to make sure that
your design fits safely in the hoop.

Attachment Point Selection Box - Click on Right to change the
attachment point to the right side.

Save As Hoop Number Selection Box - Click #7 to save this hoop
in the 7th position.
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Click on Ok to save the hoop information.

Click on Display from the Main Menu.

Click on Display Hoop to select the hoop.

Click on the hoop you just created.

As you can see, the design should fit nicely in this hoop. If not go
back to Create New Hoop. Chane your size and save the new hoop
over the same #7 hoop.

That’s how easy it is to use the Display Options in Embroidery
Magic.
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To print a design click on the Print Button in the Main Toolbar.

The Print Design Screen is displayed.

First, click on fit to page in the Page selection box, so that the
design will print at it’s largest size.

Now select Print in Color from the Color selection box to get the
full effect of the design.

Click Simulated Embroidery check box, for better representation
use the real view option.

Select the Preview button to see the view of the design before
printing.

The Preview screen is displayed.

Select whole page option button on Preview Screen, to see the
“Whole Page”.

Click Print to send the page to the printer.

That’s how easy it is to print in Embroidery Magic.

PRINTING DESIGNS



SYSTEM OPTIONS

Embroidery Magic has many options that you can customize. To
begin click on System from the Main Menu.

To turn the Grid on or off click on Grid.

As you can see the grid has been turned off, to turn it back on
repeat the same steps.

Click on System from the Main Menu again for the next option.

Click Work Area Background Color to change the color of the
Work Area Background.

The Color screen is displayed.

Click a color for the background.

Click on Ok to apply your color choice.

As you can see the background has changed to your selected color.

The next menu choice is Cursor where you can select the type of
cursor you want to use.

Click Small Cross Hairs to see the cursor look like a small cross.

From the same steps above now select the Full Screen Cross Hair.
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The Full Screen Cross Hair Cursor fills the whole work area.

From the System Menu select Set Design Colors To Default. This
choice will set the twelve needle colors back to their default
values.

The Design Colors message box is displayed.

Click Yes on the message box to set the colors to their defaults.

As you can see the needle colors have all changed back to a default
color. To set these default colors, click on System again from the
Main Menu.

Click Set Default Colors to set the colors.

The Default Colors screen is displayed.

Click on a color number to change the color of that needle.

The Color screen is displayed.

Click on a color to select it.

Click on Ok to apply the new color.

Click on Ok to save this new default color.

The next menu option is Screen Scale.
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Click on Screen Scale

The Set Screen Scale screen is displayed.

Screen Scale allows you to adjust the scaling on the screen to get
more accurate measurements. Click on Ok to continue.

The next menu option is Units of Measurement. Click to select the
Units Of Measurement you wish to use while in Embroidery
Magic.

The Units of Measurement Screen is displayed.

You can select any of the three units to work in Millimeters,
Centimeters or Inches. Click on Ok to continue.

The last option is Language. To select a new Language, simply
click on your choice. All text in the software will change to the
selected language. Click on English for no change.

That’s how easy it is to customize Embroidery Magic.
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DESIGN DATABASE

To add a design to the design database click on the Add to Data-
base Button in the Main Toolbar.

The Design Database - Add screen is displayed.

Select the category for the design you are adding. By clicking on
the down arrow you can see the existing categories.

If there is not a category that you wish to use, simply type in the
new category in the combo box.

Select the customer who you did the design for. By clicking on the
down arrow in the Customer Name combo box, you can see the
existing customers.

If this is a new customer, simply type in the name in the combo
box.

Select the design creator. By clicking on the down arrow in the
Design Created By combo box you can see the existing list of
creators. Again to add a name, simply type the name in the combo
box.

Select or type in a name.

Enter the designs selling price.
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Thread Colors/Stock #’s - This area is to keep track of thread
colors. These can be entered  in any format you like. Type in your
tread colors and stock numbers.

Click Ok to save the information.

To view and/or retrieve designs from the database click on the
Design Database Button in the Main Toolbar.

The Design Database screen is not displayed.

Click on the down arrow in the Categories combo box to view the
list of design categories.

If you can’t remember the category for a specific design you can
use the Custom Selection option.

The Design Database - Custom Selection Criteria screen is dis-
played.

To find the design we just added, lets look in all categories, Click
Select All Categories to select all.

Click to look at all stitch counts in the “Where Stitch Count is
Between...” selection box.

Click Select All Names to select all creators in teh “Where Design
Creator’s Name is...” selection box.

6/99Pantograms Embroidery Magic                      37



Click on the down arrow in the “Where Customer’s Name is...”
selection box to see the remaining customers.

Click on the customers name you typed in previously to select it.

Now click on Ok to search the database for matching designs.

The Design Database screen is displayed.

As you can see, the search found your design, Click on the design
to select it.

Now click on Edit to see the information you previously entered.

The Design Database - Edit screen is displayed.

Click on Ok to return to the previous screen.

Click on the Information button to see additional information
about the design.

The Design Database - Design Information screen is displayed.

Click on Done to return to the previous screen.

Click on Open to open the design.

That’s how easy it is to use the design database in Embroidery
Magic.
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